


 

PQASSO 3rd Edition CD-ROM FAQs 
 
Can I install PQASSO on to a server and access it from another machine? 
 
Yes. PQASSO can store its data on a network server (or on any available networked 
disk drive). To move the data on to another computer or server (e.g. so that it will be 
included in your server's backup procedure), perform the following steps: 
 

1. Install. Install PQASSO CD-ROM as normal on to the computer where you will be 
using it. 
 

2. Find the data. Using “My Computer” or Windows Explorer, navigate to the 
folder where PQASSO CD-ROM is stored. This is normally found on your hard 
disk (“C disk”), and is usually located in: 
 
a) in Windows XP and earlier,  
    “C:\Documents and Settings\All Users\Application Data\PQASSO 3\Data\”, 
 
or 
 
b) in Windows Vista, 
    “C:\ProgramData\PQASSO 3\Data\”. 
 
Note: you may not be able to see the Windows XP “Application Data” folder 
until you have enabled the ‘Show hidden files and folders’ option. To do this,  
  a. Click the “Tools” menu at the top of the window 
  b. Click “Folder options...” 
  c. Click the “View” tab at the top of the pop-up Folder Options window 
  d.  Click the “Show hidden files and folders” radio button at the bottom  
 of the Advanced settings list. 
 

3. Cut the data. Right click the “Data” folder and then left-click “Cut”. 
 

4. Go to the new data location. Navigate to the location (folder) on the server 
where you wish to store the PQASSO data. 
 

5. Paste the data. Right-click an empty space (i.e. anywhere but an existing file) 
within this target folder and then left-click “Paste”. You have now moved the 
PQASSO data to the server (or second computer). 
 

6. Tell PQASSO where its data has gone. Run PQASSO in the normal way. It will 
detect that its data has disappeared, and show a panel saying “The PQASSO 
data is not in the expected directory”. Click [OK], and PQASSO will then ask you 
for the new data location in a “Locate PQASSO data directory” window. 
Navigate into the new data folder (you will see a list of files starting with 
“Collected Evidence”) and click [Open]. Note: to find the server in the “Locate 
PQASSO data directory” window, you will probably need to use the “Look in” 
drop down list at the top of the panel. 



 

I have moved the PQASSO data on to a server. Can I access it from more than one 
computer? 
 
You can access it concurrently from as many computers as you need. However, you 
will need enough licences to cover the maximum number of users running PQASSO at 
any one time. Once you have moved the data on to a server (see “Can I install PQASSO 
on to a server” above), perform the following steps to install PQASSO CD-ROM on to 
each additional machine: 
 

1. Install. Install PQASSO CD-ROM as normal on to the additional computer where 
you will be using it. 
 

2. Tell PQASSO where the existing data can be found.  
a. Run PQASSO in the normal way.  
b. Click the blue System Menu button       on the top left-hand side of the 

window. 
c. PQASSO will display a pop-up system menu. Click the “Change data 

location” command in the pop-up menu. 
d. PQASSO will then ask you for the new data location in a “Locate PQASSO 

data directory” window. Navigate into the server's data folder (you should 
see a list of files starting with “Collected Evidence”) and click [Open].  
To find the server in the “Locate PQASSO data directory” window, you will 
probably need to use the “Look in” drop down list at the top of the panel. 
 
IMPORTANT NOTE: when accessing PQASSO data with more than one 
computer at once, each computer must have been given an identical 
network location. If, for example, the computers on your network connect 
to the shared location \\myserver\pqdata as the P: drive, all the computers 
accessing the data must be connected either to “P:” or to 
“\\myserver\pqdata”, and not some to one and some  to the other. 

 
 
 
 
 
I have moved the PQASSO data onto a server, and I have more than one licence. Can I 
run PQASSO on more than computer at once? 
 
Yes, as long as you have purchased enough additional user licences. PQASSO multi-
user licences cover concurrent users, so you will need enough licences to cover the 
maximum number of users running PQASSO at any one time.  



 

Can I transfer PQASSO from one computer to another? 
 
Yes. You will need to make a copy of the existing PQASSO data from the “old” 
computer, install PQASSO CD-ROM on to the “new” computer, and put the existing 
data back on to the new computer. To do this, perform the following steps: 
 

1. Find the existing PQASSO data. On the “old” computer, using “My Computer” or 
Windows Explorer, navigate to the folder where PQASSO CD-ROM is stored 
(usually 
“C:\Documents and Settings\All Users\Application Data\PQASSO 3\Data\” in 
Windows XP or earlier, or “C:\ProgramData\PQASSO 3\Data\” in Windows 
Vista). 
 
Note: you may not be able to see the Windows XP “Application Data” folder 
until you have enabled the ‘Show hidden files and folders’ option. To do this,  
  a. Click the “Tools” menu at the top of the window 
  b. Click “Folder options...” 
  c. Click the “View” tab at the top of the pop-up Folder Options window 
  d.  Click the “Show hidden files and folders” radio button at the bottom  
 of the Advanced settings list. 
 

2. Make a copy of the existing PQASSO data.  Copy the entire “Data” folder to 
another location on your network (accessible by both the old and new 
computers), or on to a blank CD-ROM, USB memory stick (flash drive) or tape 
backup. You have now finished work on the old computer. 
 

3. Install. Install PQASSO CD-ROM as normal on to the “new” computer. 
 

4. Find the new PQASSO data. On the “new” computer, using “My Computer” or 
Windows Explorer, navigate to the folder where PQASSO CD-ROM is stored 
(usually 
“C:\Documents and Settings\All Users\Application Data\PQASSO 3\Data\” in 
Windows XP or earlier, or “C:\ProgramData\PQASSO 3\Data\” in Windows 
Vista). 
 

5. Delete the “new” data. Right click the “Data” folder and then left-click 
“Delete”. You may need to confirm that you really do intend to delete the 
folder! 
 

6. Restore the “old” data. Using the backup you made in step 2 above, copy the 
entire data folder to the “PQASSO 2” folder. To check that you have got this 
right, there should now be a “Data” folder within the “PQASSO 2” folder, and 
the first file in the “Data” folder should be called “Collected Evidence”.  

 
 



 

Note: if you have restored the data from a CD-ROM, you may need to remove “Read-
Only” protection from the data files. To do this,  

a. right-click the “Data” folder you have just restored (on the C disk, not the 
CD-ROM ). 

b. left click “properties”. 
c. remove the tick from the “Read Only” box at the bottom 
d. click OK.  
e. The system may now display a “Confirm Attribute Changes” window. Make 

sure that “Apply changes to this folder, subfolders and files” is selected, and 
then click OK. 

 
 
When I install PQASSO as Administrator on my XP machine and then run it as a user, I 
get an error message saying that file/s cannot be located. 
 
In order to run PQASSO as a user after Administrator has installed, the following steps 
should be carried out: 
  
1) The administrator should install PQASSO as normal. 
  
2) The administrator should allow “full control” access to the data folder (usually 
“C:\Documents and Settings\All Users\Application Data\PQASSO 3\Data\” in 
Windows XP or earlier, or “C:\ProgramData\PQASSO 3\Data\” in Windows Vista) to 
normal users. 
  
If, when running PQASSO for the first time as a normal user, the “Locate Data” window 
comes up, point the program to the data folder. 
 
 
I am installing PQASSO on to more than one computer, and I’m getting the message 
“Illegal activation request – please contact CES”? 
 
If you have a multi-user licence, the information that you enter into the activation 
screen (User name, Organisation and Email) must be the same on each computer. This 
information is only used for reference, and once the software has been activated on a 
computer, the only part that is visible is the organisation name (on the “about” screen 
accessed from the “help” menu). 
 
 
I’m STILL getting the message “Illegal activation request – please contact CES”? 
 
This is a very frequently asked question. In 100% of the cases so far (and there have 
been a lot!), this problem has been due to mistyping. PQASSO will ONLY activate if 
your User Name, Organisation Name and Email address are typed in exactly the same  
on every machine on to which you have installed it. 



 

I am installing PQASSO on to more than one computer, and I’m getting the message 
“Unable to write...” or “Your system data appears to be incorrect...”.  
 
These message are usually displayed when the PQASSO software believes that there's 
a date problem with your computer, or if you don’t have permission to write to one of 
its data folders.  
  
STEP 1. The first step is to check (by double-clicking on the time on the very bottom-
right of your screen) that the date and time are (more or less) correct. If they're not, 
please adjust them. 
  
STEP 2. The second step is to check that your computer is displaying the date in 
English rather than U.S. format (i.e. 02/06/2009 rather then 06/02/2009). This can be 
done by opening up the Control Panel (click start on the bottom-left, then Control 
Panel) and then locate and click (or double-click) on the "Regional and Language 
Options" item. 
 
If the short date does not appear with the month number the middle (i.e. 
dd/mm/yyyy) between the day and the year, click the [Customize...] button to the 
right of the country drop-down to bring up the customize panel, then click the [Date] 
tab at the top, so that the customize panel is displayed. 
  
Now make sure that the short date format appears as dd/MM/yyyy, and if not, change 
it so that it does. 
 
If the problem date/time related, PQASSO should now run normally if the date and 
time are correct and the "short" date display is in UK format. 
 
STEP 3. PQASSO needs to be able to create files and write to its data folder and to its 
activation folder. 
 
The activation folder is located in 
“C:\Documents and Settings\All Users\Application Data\msavs3” (Windows XP) or 
“C:\ProgramData\msavs3”  (Windows Vista). 
 
The data folder is normally located in 
“C:\Documents and Settings\All Users\Application Data\PQASSO 3\Data” (Win XP) or 
“C:\ProgramData\PQASSO 3\Data” (Windows Vista). 
 
You can check the location of the data folder by clicking the blue System Menu 
button       on the top left-hand side of the window, then clicking the “Change data 
location” command. The resulting panel shows you where your data is stored, and you 
can check the hierarchy by clicking the “Up One Level” button      . 
 
Please ask your system administrator to check and make sure that you have “Full 
Control” privileges in both the activation folder and the data folder. 



 

When I run PQASSO, it freezes on start-up.  
 
PQASSO needs to access the website “www.pqassocd.co.uk” when it starts, to check 
for updates and activation details. Please ask your system administrator to modify 
your firewall to allow the PQASSO program, “pqasso.exe”, to access 
“www.pqassocd.co.uk”. 
 
 
 
When I run PQASSO, I keep getting the message “No location given for PQASSO data”, 
and then PQASSO disappears completely. How can I get PQASSO back? 
 
This is usually due to a failed installation, and normally occurs on very early versions 
of the PQASSO CD-ROM software. You need administrator privileges to install PQASSO 
or fix this problem (if you are on a network, consult your network administrator). To 
correct this problem, you need to run a system utility called REGEDIT, which you must 
do with great care. Perform the following steps, EXACTLY. 
 

1. Run Regedit. Click the “Start” button on the bottom-left of your screen, and 
then click “Run...” or “Run Program…”, type in “REGEDIT” and then click [OK]. 
The “Registry Editor” window will now appear. 

2. Find the PQASSO key. Using the tree in the left-hand panel, open 
‘HKEY_CURRENT_USER’, then open ‘Software’, then ‘George Lovett’, then 
‘PQASSO’, then click on ‘3.0’, The status bar on the bottom left should now read 
“My Computer\HKEY_CURRENT_USER\Software\George Lovett\PQASSO\3.0”. 

3. Delete the “DB_Path” value. In the right-hand panel, right-click “DB_Path” and 
then left-click “Delete”. You will now see “Are you sure you want to delete this 
value” - click the [Yes] button. 

4. Tell PQASSO where its data can be found. Run PQASSO in the normal way. It will 
ask you for the data location in a “Locate PQASSO data directory” window. 
Navigate into the data folder (you will see a list of files starting with “Collected 
Evidence”) and click [Open]. Note: to find the server in the “Locate PQASSO 
data directory” window, you will probably need to use the “Look in” drop down 
list at the top of the panel. 

 
 
 
 
PQASSO grinds to a complete halt or freezes for 20 minutes or more when I look at 
Collected Evidence, Overall Plan or Detailed Action Plan. How can I stop this? 
 
This is normally due to incorrectly entered dates on the Detailed Action Plan. 
Sometimes start, due or complete dates intended to be e.g. in the year 2004 have 
been entered as 0004 (i.e. 4 AD), and PQASSO will then dutifully attempt to draw 
monthly charts for 2000 years of Overall Plan display. This takes a long time. Make 
sure all dates in the Detailed Action Plan are in the 20th or 21st century! 
 
 



 

Do I need the PQASSO CD in my computer when I run the software? 
 
No, once you have installed PQASSO, you will only need the CD if you need to re-
install it for any reason. Please keep the CD and case, however – your serial number is 
written inside the case, and you will need this to complete the installation of the 
software. 
 
 
If the computer crashes can a replacement cd rom be issued? 
 
PQASSO stores its information on your computer’s internal disk drive, not on the CD 
itself. 
 
For this reason, it is very important to make regular backups of your data. 
 
If your computer crashes, you can install PQASSO on to another computer, using the 
original CD and serial number. To activate, you will need to enter exactly the same 
user name, organisation name and email address that you used on your original 
computer. Once you have installed PQASSO on to your new machine, follow the steps 
for the question “Can I transfer PQASSO from one computer to another?” above, using 
your data backup from the old machine, to restore your saved PQASSO information. 
 
 
During installation I get the message "BDE is currently running" and the installation 
aborts. Why?  
  
Systems experiencing this error generally have an application running in the 
background that uses the Borland Database Engine (BDE). One such application is 
TimeKeeper, included with TimeSlips, or Personnel Manager – Diary Monitor. Close 
the application causing the problem and restart installation. 
 
If you cannot close the application that is already running, here's a workaround that 
seems to work well (this workaround requires working with the system registry and 
should be performed by a system administrator),  
 

(a) From the 'Start' menu select 'Run...'  
(b) Enter the command 'REGEDIT'  
(c) Open the HKEY_LOCAL_MACHINE group  
(d) Open the 'Software' group 
(e) Open the 'Borland' group 
(f) Rename the 'Database Engine' folder to 'Database Engine Old'  
(g) Shutdown and restart your computer  
(h) Reinstall PQASSO  
(i) Shutdown and restart your computer. 

 
 
 


